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➢ To ensure correct and safe usage with a full understanding of this product's performance, please be
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About This Guide

This Guide explains how to print images on transparent media using white ink, which feature is a unique benefit of the XC-
540W. In this Guide you'll find detailed, step-by-step instructions on how to print an image using white ink in combination
with CMYK ink on a single sheet of transparent media. For printing operations, you'll use the RIP & Print Management
Software "Roland VersaWorks" that comes bundled with the printer.

Before Reading This Guide

Before performing any operations described in this guide, make sure that all the following preparations are complete.
� Assembling and installing the XC-540W unit
� Installing VersaWorks on your computer, and connecting the computer to the XC-540W via a network

Read the following documentation for information about setting up the XC-540W unit and VersaWorks.

(1) XC-540W Be Sure to Read  This First

This flyer includes important information that you need to know in order to use the printer. Be sure to read this before
doing anything else.

(2) XC-540W Setup Guide

This manual covers full details about how to use the XC-540W, including how to set up the printer and where to locate
the printer, etc. Read this next to the above one.

(3) XC-540W User's Manual

This manual describes operation methods in detail. After you've read the XC-540W Setup Guide, be sure to read
manual.

(4) VersaWorks Quick Start Guide

This manual explains basic operations of VersaWorks, including how to set up the program. Be sure to read Chapter 1
of this manual and make necessary setups on your computer. It is also recommended to read Chapter 2 of this manual
and become familiar with how to use this program.

Chapters in This Guide

This guide consists of the following two chapters.

Chapter 1:  Quick Start

This chapter describes the overview of available methods for printing on transparent media, and briefly explains how
to print by using each of the methods.

Chapter 2:  Tutorial

By following this chapter, you will learn how to employ two different layers of ink (CMYK and white) in a single print
on transparent media. This chapter also explains how to create data for printing using Adobe Illustrator.
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Before You Begin

Read this section before you get started with the following chapters.

Using Queue Folders (Queue Properties)

VersaWorks has two "queue folders", labeled A and B, in its main window. You can assign a set of default print settings
(queue properties) to each of these folders, and print files quickly by using the settings you have made within either of
the folders.

When you use the printer to print an image that has both CMYK color data and white data, it is recommended to use
the queue folders in the following manner.

Queue folder A ............ Use this folder to assign a set of default settings for printing CMYK color data.
Queue folder B ............ Use this folder to assign a set of default settings for printing white data.

All the operations in this guide assume that you use each of the queue folders in the manner described above.

Creating a Folder for Saving PS Files

Before you actually print an image you draw using application software such as Adobe Illustrator, it is necessary to
save the image as a PS file(s). And then, you can print the image by loading the PS file(s) on VersaWorks. Because of
this, you should create a folder for saving PS files in advance. It is recommended to locate the folder in the root
directory on your computer's local disk.

� Open [My Computer], and then open [Local Disk (C:)].

� On the [File] menu, click [New], and then click [Folder].

� Enter the name for the folder, and then press the Enter key.
� Here you name "white_print", for example.
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Chapter 1
Quick Start

This chapter describes the overview of available methods for printing on

transparent media, and briefly explains how to print by using each of the

methods.
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1-1  Transparent Media Print Overview

About Methods for Printing on Transparent Media

In addition to employing only CMYK colors or only white when printing on transparent media, you can employ both
of them in a single print.
The following is an example image of a CMYK and white double-layered print.

When you print a layer on another layer, you need to choose which type of layer (CMYK or white) to print first. It is
determined whether you want to have the printed image from the side of the printing surface or the opposite side of the
printing surface.

You will use the above example image and data examples when you perform the operations in the following section.

Note
This chapter does not cover information about how to create data for a double-layered print. For details, see "2-2
Creating Data for Printing" (page 23) in Chapter 2.

CMYK color data example:
"Flag_Color.ps"

White data example:
"Flag_White.ps"

Printed image

When you want to have the printed image from
the printing surface of the media:
Print the white data first, and then the CMYK color data.
We call this "CMYK-on-white method".

Transparent
media

See the printed image
from this side

When you want to have the printed image from the
opposite side of the printing surface of the media:
Print the CMYK color data first, and then the white data.
We call this "CMYK-under-white method".

See the
printed image
from this side
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Available Printing Modes

Each time you perform a single print operation (that is, a single print job) is performed using VersaWorks, an appropri-
ate "printing mode" must be selected in accordance with the method you take, which is described on the last page,
and the type of ink (CMYK or white) you use.

Printing Mode

CMYK (v) +PASS

CMYK (v) onWhite +PASS

CMYK (v) underWhite +PASS

White (v) W-PASS

Description

Select this mode when you print using only CMYK ink. White
ink is not used.

This mode is for printing using white ink, then overprinting
the white undercoat with CMYK ink.

This mode is for printing with CMYK ink first, then over-
printing with white ink.

Select this mode when you print using white ink. This mode
is available regardless of using only white ink or using white
ink in combination with CMYK ink.
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1-2  Printing on Transparent Media

This section explains how to print on transparent media by using each of four different methods.

Printing White Data and then CMYK Color Data (CMYK-On-White)

Use the CMYK-on-white method when you want to have a printed image as illustrated below.

When the media is viewed from its printed surface, the CMYK-color layer is printed on top of the white layer,
so you make the "CMYK on White" setting when you're printing using CMYK colors.

1. Prepare the printer.

� Press and make the following settings.

Set [EDGE DETECTION] to "DISABLE".

� Load transparent media into the printer.
� When the media you are loading into the printer warps or partially floats from the platen, load it into the

printer so that its front end goes about 20 cm (8 in.) from the starting edge of the print area.
� Be sure to use the media clamps when you load media.

2. Prepare the image files for printing.

After drawing an image using application software such as Adobe Illustrator, you need to create two PS files - one
for printing the white layer of the image, and the other for printing the CMYK layer of the image. In the following
procedures, it is assumed that you use the following files for printing: "Flag_Color.ps" which contains CMYK layer
of the image, and "Flag_White.ps" which contains white layer of the image.

Notice on drawing white layer of the image
Make sure that you set the color of any objects in the white layer of the image between K0% and K100% in the CMYK
mode. This rule also applies when you want to use gradient colors.

Transparent media

Printing surface of the media:
white layer is printed first, and
then CMYK layer is printed
on it.

White layer

CMYK layer

You will have the
printed image from this
side (the printing
surface of the media).
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3. Start up VersaWorks on your computer.

Check the printer model and status in the main window.

4. Assign the settings for printing the white layer of the image to queue folder B.

� Double-click .

� In the [Queue B Properties] dialog box that appears, make the following settings.

* It is recommended that you use an auxiliary drying unit (DU-540). The dry time setting here (15 minutes)
applies when you use an auxiliary drying unit (DU-540).

� Click [OK] to close the [Queue B Properties] dialog box.

Icon
Quality

Printer Controls

Cut Controls

Setup item
Media Type

Mode

Ohter Controls

Dry Time*

Operation Mode

Return to Origin After Print

Setting
"Clear PET Film" or "PET Clear Film, Adhesive"

White (v) W-PASS

Use Custom Settings

15 Minutes

Print Only

On
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5. Assign the settings for printing the CMYK layer of the image to queue folder A.

� Double-click .

� In the [Queue A Properties] dialog box that appears, make the following settings.

* It is recommended that you use an auxiliary drying unit (DU-540). The dry time setting here (15 minutes)
applies when you use an auxiliary drying unit (DU-540).

� Click [OK] to close the [Queue A Properties] dialog box.

6. In the Queue B Job List, drag and drop the white data PS file (Flag_White.ps).

� Click the [Queue B] tab in the main window so that the title above the tab changes to "Job List -
Queue B".

� Click the file "Flag_White.ps" that you created in step 2., drag it in the job list, and then drop it
(release the mouse button).

Icon
Quality

Printer Controls

Cut Controls

Setup item
Media Type

Mode

Ohter Controls

Dry Time*

Operation Mode

Return to Origin After Print

Setting
"Clear PET Film" or "PET Clear Film, Adhesive"

CMYK (v) onWhite +PASS

Use Custom Settings

15 Minutes

Print Only

Off
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7. In the Queue A Job List, drag and drop the CMYK color data PS file (Flag_Color.ps).

� Click the [Queue A] tab in the main window so that the title above the tab changes to "Job List -
Queue A".

� Click the file "Flag_Color.ps" that you created in step 2., drag it in the job list, and then drop it
(release the mouse button).

Observe that both the white image and CYMK color image are displayed in the same size in the layout window
(the right part of the VersaWorks window).

8. Print the white data.

� Click the [Queue B] tab in the main window.

� In the job list, click "Flag_White.ps" so that it is selected.

� Click  to start printing.
� After printing is complete, it takes approximately 15 minutes to dry out the media.
� When the media is dried out, it will return to the original position automatically.

9. Print the CMYK color data.

� Click the [Queue A] tab in the main window.

� In the job list, click "Flag_Color.ps" so that it is selected.

� Click  to start printing.
� After printing is complete, it takes approximately 15 minutes to dry out the media.

Printing another double-layered image in the same way
When you complete the above procedures, you can use another set of white data and CMYK color data by performing
steps 6. through 9. to print another image.
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Printing CMYK Color Data and then White Data (CMYK-Under-White)

Use the CMYK-under-white method when you want to have a printed image as illustrated below.

When printing by using this method, it is necessary to print the mirror image of the original, because you will
look at the printed image from the opposite side of the printing surface.

1. Prepare the printer.

� Press and make the following settings.

Set [EDGE DETECTION] to "DISABLE".

� Load transparent media into the printer.
� When the media you are loading into the printer warps or partially floats from the platen, load it into the

printer so that its front end goes about 20 cm (8 in.) from the starting edge of the print area.
� Be sure to use the media clamps when you load media.

2. Prepare the image files for printing.

After drawing an image using application software such as Adobe Illustrator, you need to create two PS files - one
for printing the white layer of the image, and the other for printing the CMYK layer of the image. In the following
procedures, it is assumed that you use the following files for printing: "Flag_Color.ps" which contains CMYK layer
of the image, and "Flag_White.ps" which contains white layer of the image.

Notice on drawing white layer of the image
Make sure that you set the color of any objects in the white layer of the image between K0% and K100% in the CMYK
mode. This rule also applies when you want to use gradient colors.

You will have the
printed image from
this side (the opposite
side of the printing
surface of the media).

Printing surface of the
media: CMYK layer is
printed first, and then white
layer is printed on it.

CMYK layer

White layer

Transparent media
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3. Start up VersaWorks on your computer.

Check the printer model and status in the main window.

4. Assign the settings for printing the CMYK layer of the image to queue folder A.

� Double-click  .

� In the [Queue A Properties] dialog box that appears, make the following settings.

* It is recommended that you use an auxiliary drying unit (DU-540). The dry time setting here (15 minutes)
applies when you use an auxiliary drying unit (DU-540).

� Click [OK] to close the [Queue A Properties] dialog box.

Setup item
Mirror

Media Type

Mode

Ohter Controls

Dry Time*

Operation Mode

Return to Origin After Print

Setting
On

"Clear PET Film" or "PET Clear Film, Adhesive"

CMYK (v) underWhite +PASS

Use Custom Settings

15 Minutes

Print Only

On

Icon
Layout

Quality

Printer Controls

Cut Controls
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5. Assign the settings for printing the white layer of the image to queue folder B.

� Double-click .

� In the [Queue B Properties] dialog box that appears, make the following settings.

* It is recommended that you use an auxiliary drying unit (DU-540). The dry time setting here (15 minutes)
applies when you use an auxiliary drying unit (DU-540).

� Click  [OK] to close the [Queue B Properties] dialog box.

6. In the Queue A Job List, drag and drop the CMYK color data PS file (Flag_Color.ps).

� Click the [Queue A] tab in the main window so that the title above the tab changes to "Job List -
Queue A".

� Click the file "Flag_Color.ps" that you created in step 2., drag it in the job list, and then drop it
(release the mouse button).

The preview image of the file itself is displayed in the preview window, and the mirror image of the original is
displayed in the layout window (to the right of the preview window).

Icon
Layout

Quality

Printer Controls

Cut Controls

Setup item
Mirror

Media Type

Mode

Ohter Controls

Dry Time*

Operation Mode

Return to Origin After Print

Setting
On

"Clear PET Film" or "PET Clear Film, Adhesive"

White (v) W-PASS

Use Custom Settings

15 Minutes

Print Only

Off
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7. In the Queue B Job List, drag and drop the white data PS file (Flag_White.ps).

� Click the [Queue B] tab in the main window so that the title above the tab changes to "Job List -
Queue B".

� Click the file "Flag_White.ps" that you created in step 2., drag it in the job list, and then drop it
(release the mouse button).

Observe that both the white image and CYMK color image displayed in the layout window are the same size.

8. Print the CMYK color data.

� Click the [Queue A] tab in the main window.

� In the job list, click "Flag_Color.ps" so that it is selected.

� Click  to start printing.
� After printing is complete, it takes approximately 15 minutes to dry out the media.
� When the media is dried out, it will return to the original position automatically.

9. Print the white data.

� Click the [Queue B] tab in the main window.

� In the job list, click "Flag_White.ps" so that it is selected.

� Click  to start printing.
� After printing is complete, it takes approximately 15 minutes to dry out the media.

Printing another double-layered image in the same way
When you complete the above procedures, you can use another set of CMYK color data and white data by performing
steps 6. through 9. to print another image.
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Printing Only White Data

1. Prepare the printer.

� Press and make the following settings.

Set [EDGE DETECTION] to "DISABLE".

� Load transparent media into the printer.
� When the media you are loading into the printer warps or partially floats from the platen, load it into the

printer so that its front end goes about 20 cm (8 in.) from the starting edge of the print area.
� Be sure to use the media clamps when you load media.

2. Prepare the image files for printing.
Draw an image using application software such as Adobe Illustrator, and then save the image as a PS file.

Important!
Make sure that you set the color of any objects in the image between K0% and K100% in the CMYK mode.
The above rule also applies when you want to use gradient colors.

3. Start up VersaWorks on your computer.
Check the printer model and status in the main window.

4. Make necessary settings for printing the image to queue folder B.

� Double-click .

� In the [Queue B Properties] dialog box that appears, make the following settings.

* It is recommended that you use an auxiliary drying unit (DU-540). The dry time setting here (15 minutes)
applies when you use an auxiliary drying unit (DU-540).

� Click  [OK] to close the [Queue B Properties] dialog box.

5. In the Queue B Job List, drag and drop the PS file.

� Click the [Queue B] tab in the main window so that the title above the tab changes to "Job List -
Queue B".

� Click the PS file that you created in step 2., drag it in the job list, and then drop it (release the
mouse button).

6. Click  to start printing.
� After printing is complete, it takes approximately 15 minutes to dry out the media.

Icon
Quality

Printer Controls

Setup item
Media Type

Mode

Ohter Controls

Dry Time*

Setting
"Clear PET Film" or "PET Clear Film, Adhesive"

White (v) W-PASS

Use Custom Settings

15 Minutes
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Printing Only CMYK Color Data

1. Prepare the printer.

� Press and make the following settings.

Set [EDGE DETECTION] to "DISABLE".

� Load transparent media into the printer.
� When the media you are loading into the printer warps or partially floats from the platen, load it into the

printer so that its front end goes about 20 cm (8 in.) from the starting edge of the print area.
� Be sure to use the media clamps when you load media.

2. Prepare the image files for printing.

Draw an image using application software such as Adobe Illustrator, and then save the image as a PS file.

3. Start up VersaWorks on your computer.

Check the printer model and status in the main window.

4. Make necessary settings for printing the image to queue folder A.

� Double-click .

� In the [Queue A Properties] dialog box that appears, make the following settings.

� Click  [OK] to close the [Queue A Properties] dialog box.

5. In the Queue A Job List, drag and drop the PS file.

� Click the [Queue A] tab in the main window so that the title above the tab changes to "Job List -
Queue A".

� Click the PS file that you created in step 2., drag it in the job list, and then drop it (release the
mouse button).

6. Click  to start printing.

Icon
Quality

Setup item
Media Type

Mode

Setting
"Clear PET Film" or "PET Clear Film, Adhesive"

CMYK (v) +PASS
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1-3  Cutting the Media After Printing

After printing is complete, it is possible to let the printer cut the media automatically along the "contour lines" you have
drawn in the image. This feature is useful, for example, when you want to make stickers using adhesive transparent film
media.
For information about how to draw contour lines, see "Roland VersaWorks Quick Start Guide".

Cutting the Media After Printing White Data and then CMYK Color Data

Perform the same operations under "Printing White Data and then CMYK Color Data" (page 8), except for the follow-
ing changes.

� In step 2., draw the contour lines in the image you want to print, along with the CMYK layer of the image. When
you save the CMYK layer of the image as a PS file, make sure that the contour lines are also included. Save the
white layer of the image as a PS file without contour lines.

� Perform the following operations instead of step 9..

� Click the [Queue A] tab in the main window.

� In the job list, double-click "Flag_Color.ps" (the PS file which contains the contour lines data along
with the CMYK color data).

� In the [Job Settings] dialog box that appears, make the following settings, and then click  [OK].

� Click  to start printing.

Cutting starts automatically after printing and dry-out operations are complete.

Cutting the Media After Printing CMYK Color Data and then White Data

Perform the same operations under "Printing CMYK Color Data and then White Data" (page 12), except for the follow-
ing changes.

� In step 2., draw the contour lines in the image you want to print, along with the white layer of the image. When you
save the white layer of the image as a PS file, make sure that the contour lines are also included. Save the CMYK
layer of the image as a PS file without contour lines.

� Perform the following operations instead of step 9..

� Click the [Queue B] tab in the main window.

� In the job list, double-click "Flag_White.ps" (the PS file which contains the contour lines data along
with the white data).

� In the [Job Settings] dialog box that appears, make the following settings, and then click [OK].

� Click  to start printing.

Cutting starts automatically after printing and dry-out operations are complete.

Icon
Cut Controls

Setup item
Operation Mode

Setting
Print & Cut

Icon
Cut Controls

Setup item
Operation Mode

Setting
Print & Cut
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Cutting the Media After Printing Only White Data or CMYK Color Data

Perform the same operations under "Printing Only White Data" (on page 16) or "Printing Only CMYK Color Data" (on
page 17), except for the following changes.

� In step 2., draw the contour lines in the image you want to print, and then save the image as the PS file with the
contour lines data included.

� Perform the following operations instead of step 6..

� In the job list, double-click the PS file that you want to use for printing and cutting.

� In the [Job Settings] dialog box that appears, make the following settings.

� Click  to start printing.

Cutting starts automatically after printing and dry-out operations are complete.

Icon
Cut Controls

Setup item
Operation Mode

Setting
Print & Cut
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Chapter 2
Tutorial

This chapter describes detailed information about how to print two layers

(CMYK layer and white layer) on a single sheet of transparent media, start-

ing with drawing an image that consists of two layers using Adobe Illustra-

tor.
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2-1  Tutorial Overview

Getting through this tutorial, you will learn basic concepts and detailed operations on how to print an image, which consists
of CMYK layer and white layer, on a single sheet of transparent media.

Example Image for This Tutorial

As an example, you will use a label for mineral water package like the one shown below in this tutorial.

To make the most of transparent media, here you print the image so that you will have the printed image from the
opposite side of the printing surface of the media.
See "About Methods for Printing on Transparent Media" (on page 6) for more information.

Basic Flow

There are the following three sections, or groups of procedures you will follow in this tutorial.

2-2  Creating Data for Printing page 23

To print an image like the above example, you have to draw the image first, and then create two separate PS files
for CMYK color and white. In this section you will draw the original image using Adobe Illustrator CS2 and create
PS files for printing.

2-3  Making Default Settings for Printing (Using Queue Properties) page 30

You will use VersaWorks from this section.
In this section, you will make two sets of default settings for printing - settings in [Queue A Properties] and
[Queue B Properties].

2-4  Making Job Settings and Printing the Image page 33

In this section, you will print CMYK color data and white data using VersaWorks. You will also learn relationship
between the [Queue A (B) Properties] dialog box and the [Job Settings] dialog box, and perform actual settings in
the [Job Settings] dialog box under "Operational Procedures".
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2-2  Creating Data for Printing

Basic Ideas of Creating Data

You will use two layers (CMYK and white) to print a single image, so keep the following things in mind:

� Make the two layers precisely form the image you expect when you create data for each layer.
You can use any application software as far as it can save files in a format that can be loaded into VersaWorks.
Commonly, it is recommended that you use Adobe Illustrator, because you can create multiple drawing layers in a
single file.

� Save each of the layers as a PS file before you actually print the image.
You will print each of the layers separately, so it is necessary to create two separate PS files.

Spelling out the obvious about white...
� Usually, you use white paper for printing an image. When the image has white part, it means that the part has no

color (C=0%, M=0%, Y=0%, K=0% in CMYK). When printed on the paper, of course, no color of ink is on it where
the image is white. If you use transparent media for printing the image, this "white" part of the image becomes
transparent, because no ink is on the media. If you want to have white part printed white on transparent media, you
simply need to use white ink. A PS file that contains white layer of the image, or white data, is necessary for printing
with white ink.

� When you create data for white layer of the image on your computer, you have to use solid black (K=100%) for
drawing objects in it. Solid black is interpreted as solid white when the data is printed.

Basic Flow

Roughly design or draw your image which contains white part as an element of the image.

Draw the image you have designed on your computer using Adobe Illustrator or other graphic application software.

� If you use Adobe Illustrator, draw the CMYK color part of the image in one layer, and the white part of the
image in another layer.

� If you use other application software, it is necessary to think about how to draw each of the layers. You may be
able to draw both layers in a single file just as you can do using Adobe Illustrator, or you may have to create
a file for each layer. It depends on the application software you use.

Save the file(s) that contains the image you have drawn as PS files.

� If you use Adobe Illustrator, save each of the layers (CMYK layer and white layer) in the file you draw as a PS
file. As a result, you will have two separate PS files - one for the CMYK layer of the image, and the other for the
white layer of the image.

� The above rule also applies when you use other application software. Make sure that you create one PS file
per each of the layers of the image.

Operational Procedures

In this example you will use Adobe Illustrator CS2 to create data for printing.

Important!
� For details about how to use Adobe Illustrator CS2 such as drawing objects or handling layers, see the manual

or online help that come with it.
� If you use one of the other versions of Adobe Illustrator, operations may be somewhat different from those

explained here.
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1. To draw an image using two layers

� First, draw a full-color image (like the one shown below) in the CMYK mode.

Note the following when drawing:
� Make sure that you use the CMYK mode of the application software.
� Draw all the objects in a single layer. If you use multiple layers while drawing, be sure to move all the objects

to a single layer before proceeding. In the following steps, it is assumed that all the objects are in "Layer 1".

� Rename the name of the layer "Layer 1" to "Color".

�
Select [Layers] from the [Window] menu
so that the Layers palette is displayed.
The above operation is not necessary if the Layer pal-
ette is already displayed.

�
Click  and select [Options for "Layer 1"].

�
On the [Layer Options] dialog box that ap-
pears, enter "Color" in the [Name] box, and
then click  [OK].
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� Insert a new layer named "White".

�On the Layers palette menu, click [New Layer].

�On the [Layer Options] dialog box that appears, enter "White" in the [Name] box, and then click
[OK].

This inserts the "White" layer above the "Color" layer, and the "White"
layer becomes active for drawing.

� Draw the white layer of the image in the layer "White".

Note the following when drawing:
� Make sure that you draw any objects in solid black (K100%). Otherwise the image may not be printed cor-

rectly.
� Draw objects carefully so that the image in the white layer and image in the CMYK layer are aligned precisely.

You can easily draw two objects precisely aligned, each of which is in different layers. The following is an
example of operations for the sample image of this tutorial.

�Select the outline rectangle object in the "Color" layer, and then select [Copy] from the [Edit] menu.

�Activate the "White" layer for drawing.

�Select [Paste in Front] from the [Edit] menu.
This pastes the copied rectangle object right in front of the original object in the "White" layer.

�Set the fill color of the pasted object to K100%.
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2. To save the CMYK layer of the image as a PS file.

� By using the Layers palette, hide the "White" layer and display only the "Color" layer.

� Select [Print] from the [File] menu.

� Perform the following operations in the Windows [Print] dialog box.

�
Select [Roland VW].

�
Click [Setup].

�
Click [Continue].

�
Turn on the [Print to file] option.

�
Click [Preferences].
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�Click [OK] three times to close each of the dialog boxes.
Return to the Windows [Print] dialog box.

�Click [Print].

�
Click the down arrow to the right of the [Pa-
per Size] box, and then click [PostScript Cus-
tom Page Size] from the list that appears.

�
Click [Advanced] in the [Layout] tab.
If you're using Windows 2000, click the [Layout] tab on
the [Print] dialog box, and then click Advanced instead
of the above operation.

�
Enter appropriate values to [Width] and
[Height] under [Custom Page Size Dimen-
sions].
Make sure that you specify the values to fit the image
you draw in step 1..
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� Specify a location and a file name for saving the CMYK layer of the image as a PS file.

For the location to save the PostScript file, specify the "C:\white_print\" folder here.
The file is named "label_color.ps" in this example.

The print preview image will be shown
here. Check if the image fits the page
size that you specified in step �.

�
Click [Print].

�
See "Creating a Folder for Saving
PS Files" on page 3 for more infor-
mation.

�
Click [Save].
The CMYK layer of the image is saved as a
PS file.

�
For the file name, specify such a
name as you can easily recognize
the image and the layer (CMYK)
contained in the file.Be sure to specify ".ps" as

the file extension.



2-2  Creating Data for Printing

29Chapter 2 Tutorial

3. To save the white layer of the image as a PS file.

� By using the Layers palette, hide the "Color" layer and display only the "White" layer.

� Perform the same operations as steps 2. � through �.

Important!
� Make sure that you specify the values for [Width] and [Height] under [Custom Page Size Dimensions] identi-

cal to those of the values you specify in step 2.� � for the CMYK layer of the image. If you specify wrong
values, the white layer of the image won't be aligned precisely with the CMYK layer of the image when
printed.

� When saving the white layer of the image as a PS file, locate it in the folder "C:\white_print\", which is the
same one as you saved the PS file for the CMYK layer of the image in.  Also, name the PS file like "label_white.ps",
which name is easily recognized as the white layer of the image.

4. Open the folder that you specified for saving the PS files, and check if the PS
files are correctly saved.

The following screen shows an example when you saved the PS files under "C:\white_print\".
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2-3 Making Default Settings for Printing (Using Queue Properties)

Queue Properties Overview

Before you start printing the PS files you saved under "2-2 Creating Data for Printing" (on page 23), you can make
default settings such as selecting the media and mode for printing in the VersaWorks program.
VersaWorks has two "queue folders", labeled A and B, in its main window. You can assign a set of default print settings
to each of these folders using the [Queue A (B) Properties] dialog box, which is displayed by double-clicking either of
the queue folders.

In the following operations, you will use the queue folders as described below.

Queue folder A ............ Use this folder to assign default settings for printing CMYK color data (that is,
CMYK layer of the image).

Queue folder B ............ Use this folder to assign default settings for printing white data (that is, white layer
of the image).

Note
It is possible to make changes to the default settings independently before printing each file by using the [Job Settings]
dialog box for each of print jobs. Concepts and Operations of the [Job Settings] dialog box will be mentioned later
under "2-4 Making Job Settings and Printing the image" (on page 33).

Operational Procedures (Printing CMYK Color Data and then White Data)

1. Start up VersaWorks on your computer.

Check the printer model and status in the main window.
Printer model :  SOLJET ProIII  XC-540
Status :  Ready to Print

For details about how to connect the printer to the computer that the VersaWorks program installed, see "VersaWorks
Quick Start Guide" or the online help.
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2. To assign default settings for printing CMYK color data to the Queue folder A.

� Double-click .
The [Queue A Properties] dialog box is displayed.

� In the [Queue A Properties] dialog box, make the following settings.

* It is recommended that you use an auxiliary drying unit (DU-540). The dry time setting here (15 minutes)
applies when you use an auxiliary drying unit (DU-540).

The following shows an example steps to change the settings included in the [Printer Controls] icon.

�Click .
The setup items displayed to the right changes to those related to controlling the printer.

�Select [Use Custom Settings] for [Ohter Controls].

�Select 15 (Minutes) for [Dry Time].

� Click [OK] to close the [Queue A Properties] dialog box.

Each of the icons shown in the left of
the dialog box represents a group of
related setup items.

By clicking one of the icons, the setup
items contained in corresponding group
are displayed in the right of the dialog
box.

Icon
Layout

Quality

Printer Controls

Setup item
Mirror

Media Type

Mode

Ohter Controls

Dry Time*

Setting
On

"Clear PET Film" or "PET Clear Film, Adhesive"

CMYK (v) underWhite +PASS

Use Custom Settings

15 Minutes
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3. To assign default settings for printing white data to the Queue folder B.

� Double-click .
The [Queue B Properties] dialog box is displayed.

� In the [Queue B Properties] dialog box, make the following settings.

* It is recommended that you use an auxiliary drying unit (DU-540). The dry time setting here (15 minutes)
applies when you use an auxiliary drying unit.

� Click [OK] to close the [Queue B Properties] dialog box.

Icon
Layout

Quality

Printer Controls

Setup item
Mirror

Media Type

Mode

Ohter Controls

Dry Time*

Setting
On

"Clear PET Film" or "PET Clear Film, Adhesive"

White (v) W-PASS

Use Custom Settings

15 Minutes
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2-4  Making Job Settings and Printing the Image

Job Settings Overview

As described in "Queue Properties Overview" on page 30, you can make default settings for printing using the [Queue
A (B) Properties] dialog box. By using the [Job Settings] dialog box, you can change the default settings independently
for each of print jobs, before printing.
Registering default settings to the queue folders is a smart way especially when you print a large number of files that
you can print in almost the same settings. Even if some of the files need slight changes to the default settings, you can
easily make it by using the [Job Settings] dialog box for each of the files.

The following screens show examples of the [Queue A Properties] dialog box and the [Job Settings] dialog box. You
can find that the contents of these two dialog boxes are identical except that the preview image for the corresponding
job is indicated only in the [Job Settings] dialog box, in the right side of it.

[Queue A Properties] dialog box [Job Settings] dialog box

You don't have to open the [Job Settings] dialog box when the file you print needs no change to the default settings you
use to print it. Open the [Job Settings] dialog box as you think it's necessary to check or change the settings.

Setting Up the Printer (Do This Before You Print!)

Be sure to perform the following operations on the printer before you print. See the manual that comes with the printer
for detailed information about how to operate the printer.

� Press and make the following settings.

Set [EDGE DETECTION] to "DISABLE".

� Load transparent media into the printer.
� When the media you are loading into the printer warps or partially floats from the platen, load it into the

printer so that its front end goes about 20 cm (8 in.) from the starting edge of the print area.
� Be sure to use the media clamps when you load media.



2-4  Making Job Settings and Printing the Image

34 Chapter 2 Tutorial

Printing CMYK Color Data

� Click the [Queue A] tab in the main window so that the title above the tab changes to "Job List -
Queue A".

� Hold down the PS file "label_color.ps",  which you have created by following the operations under
"2-2 Creating Data for Printing" (on page 23).

� Drag the file in the job list, and then drop it (release the mouse button).

The file "label_color.ps" appears in the Queue A Job List, which means the file is added to the job list as a new
print job.

� In the Queue A Job List, double-click the file "label_color.ps".
The [Job Settings] dialog box for the file is displayed.

� Click .
The setup items displayed to the right changes accordingly.

� Select [Print Only] from the [Operation Mode] box, and then turn the [Return to Origin After
Print] option on.

	 Click [OK] to close the [Job Settings] dialog box.


 Click  to start printing the file.
� After printing is complete, it takes approximately 15 minutes to dry out the media.
� When the media is dried out, it will return to the original position automatically.
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Printing White Data

� Click the [Queue B] tab in the main window so that the title above the tab changes to "Job List -
Queue B".

� Hold down the PS file "label_white.ps",  which you have created by following the operations under
"2-2 Creating Data for Printing" (on page 23).

� Drag the file in the job list, and then drop it (release the mouse button).

The file "label_white.ps" appears in the Queue B Job List with it is highlighted.

Note
You can use the default settings stored in Queue B Properties as they are. Because of this, it's not necessary to
open the [Job Settings] dialog box here.

� Click  to start printing the file.
� After printing is complete, it takes approximately 15 minutes to dry out the media.
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